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File Menu
The file menu contains commands for loading and saving disk files.

New
Open
Save
Save As
Save Setup
Read Setup
Exit



New
The New command erases the current sequence from memory (RAM). If the current 
sequence has not been saved since the last change, a message will appear before it erases 
the sequence. The message will let you decide if you wish to continue and abandon your 
work, save the sequence to disk, or cancel the New command.



Open
The Open command lets you open previously saved sequences into the sequencer.    The 
Song Selector dialog box will pop up to let you choose from a list of files.

If the current sequence has not been saved since the last change, a message will appear 
before it erases the sequence. The message will let you decide if you wish to continue and 
abandon your work, save the sequence to disk, or cancel the Open command.

The Song Selector dialog box is exactly like the File Selector dialog box except for one 
addtional feature. The Song Selector dialog box also has an option to let you select either a 
Cadenza song file or a standard MIDI file. The list will display files that match the type you 
select.



Save

The Save command saves the current song to disk. The first time you save a song, the Song 
Selector dialog box will pop up so you can name your song. If your song has already been 
named, choosing the save command will immediately save your latest work to disk, and 
allow you to continue to work on your sequence. 



Save As

The Save as command allows you to give a new song a name, or save the current song 
under a different name than currently used. This is useful when you want to keep several 
versions of the same song. It is also useful for making backup files of your song (just save 
them under a different filename, or to a different disk or directory).

The Song Selector dialog box (see Open commandcmd_open) will pop up so that you can 
enter the name.    You may instead want to use one of the names from the list. In this case, 
you will overwrite the existing file.



Save Setup

This saves the control settings as the default setup. Each time the sequencer is started or 
the New command is used, the sequencer will be restored to this configuration. The settings 
that are saved are, Tempo, Key Signature, Metronome, Lead-in, MIDI control options, MIDI 
Echo, Overdub. Many different setups may be saved. The setups are written to disk so they 
may be recalled later. All setup file names have an extension of CFG. To make these your 
default settings when Cadenza first starts up, save then in the file called CADENZA.CFG.



Read Setup

This reads in a new setup from a previously saved setup file. Each time the NEW command is
used, the sequencer will be restored to this configuration. The initial default settings of 
Cadenza are determined by the setup in the CADENZA.CFG    file. After Cadenza is started, 
you may load any other setup file you like.



Exit

The Exit command closes Cadenza. If the current sequence has not been saved since the 
last change, a message will appear before Cadenza closes. The message will let you decide 
if you wish to continue and abandon your work, save the sequence to disk, or cancel the Exit
command.



Edit Menu
Undo
Cut
Copy
Paste
Clear
Delete
Event Filter
Quantize
Humanize
Slide
Length
Rechannel
Retrograde
Transpose Pitch
Remap
Comments
Blocks
Mark to Start
Mark to End
Mark All



Undo

Undo will reverse the last edit to a track. The Undo command is only enabled when there is 
something to undo.    Once you do a regional edit operation, Undo becomes active. After it is 
used, Undo becomes disabled until the next regional edit. 



Cut

Works just like COPY except that the copied material is removed from the tracks. This 
command is used with the PASTE command to move a region from one part of the song to 
another.



Copy 

This command copies all block marked events into the clipboard. The command can be used 
with the Paste command to copy a region from one part of a song to another.



Paste

Events copied to the clipboard by the Copy or Cut commands may be pasted elsewhere in 
your song using this command. The PASTE dialog box lets you enter the song position where 
the material will be placed and how many times the paste is to be repeated. Each paste 
iteration begins at the measure immediately following the end of the previous iteration.

The merge option lets the clipboard data go directly over the existing song. If the option is 
off then the material is inserted. Enough measures will be inserted to make room for the new
material.



Clear

Erases block marked events. This command works like the Cut command, except the events 
removed are not saved in the clipboard 



Delete

Erases block marked events. The space previously occupied by these events is also 
removed. In other words, the gap is removed. The size of the gap is exactly the same size as
the marked block. 



Event Filter

The Event Filter is used to specify which events will be afftect by the regional editing 
commands.



Quantize

This command lets you correct slight timing errors in a song. Select the events to quantize, 
then select the QUANTIZE function. 



Humanize

Humanize allows you to make a performance    which has been stepped in or one that has 
been over quantized sound more natural or human. It adds randomness to the timing and 
duration of each note. The Humanize Dialog lets you set the amount of deviation added to 
each note's velocity, song position and duration.



Slide

This command shifts the block marked events in time. Enter the amount of shift in the dialog
box. The time is in duration format (measures:beats:ticks).



Length

The Length command can be used to shorten or lengthen block marked events. This can be 
used to get staccato effects. It expands and compresses the time and duration of the block 
marked events. Enter the percentage of change into the dialog box. The event time and note
duration can have different values. To double the length of a region, use 200 in both entries. 
To create staccato from legato, set time to 100 and duration to 50. This forces notes to have 
a duration of 50% of their original duration.



Rechannel

When notes are recorded, they are assigned the channel that they were received on. This 
command allows a new choice of channel for the block marked events.



Retrograde

Retrograde reverses the order of the notes in a block marked region. The first note in the 
region becomes the last note of the region and so on. Its note position will be such that the 
beginning of the note is the same distance from the end of the region as it used to be from 
the beginning of the region.

Typically, you would set the region from the beginning of the first note to the beginning of 
the last note to be effected.



Transpose Pitch

This command changes the pitch of the block marked notes. Two methods for transposing 
are provided.    You have a chose of transposing by halfsteps or transposing by range.
 



ReMap

Use this command to convert a group of controller events from its current type to another. 
For example, Aftertouch could be converted to Modulation Wheel data.



Comments

The Comments command lets you enter notes about the current song into a notepad. After 
you are done editing, close the editor using the Close command in the window's system 
menu. You may also double-click on the system menu box. The notes are saved on disk with 
the song. When the song is reloaded, the comments command can be used to display the 
notes. The comments are saved in a separate file from the rest of the song. The file will have
the same name as the song except the extension will be .TXT. 



Blocks

This command provides you with a way to view and edit the list of marked regions. The 
dialog box displays a list of the regions. The pushbuttons let edit, delete, or add regions. 

To add a block, click on the Add button, then enter the region boundaries in the next dialog 
box. The new region will appear in the listbox.

To edit a region. select the region in the listbox, then click on the Edit button. Enter the new 
boundaries in the dialog box.

To delete a region, select the region from the listbox, then click on the Delete button.



Mark to Start

Creates a block marked region from the current song position to the begining of the song.



Mark to End

Creates a block marked region from the current song position to the end of the song.



Mark All

Block marks the entire song. Actually it removes all block marking. This has the same effect 
as marking the whole song.



Track Menu
Links
Copy
Merge
Select
Status
Save Mute Map
Load Mute Map
Erase
Kill



Links

The Links command lets you link tracks together. To link your tracks, select an empty track 
and place it into Link mode (instead of Linear mode).    Use the Track Sheet to select the 
mode. Select the Link command from the track menu. The Links dialog box is used to specify
the order that the tracks are played.    To add track numbers to the list, enter the track 
number in to edit box and click on the Add button. If you wish to insert a track number, click 
on the track in the list where you want the new track inserted. Enter the track number in the
edit box then click on the Add button. The new track will be inserted in front of the track you 
selected from the list. To remove a track from the list, select the track from the list and click 
on the Delete button. 

When you are done editing the list, click on the OK button to save your work. If you wish to 
abandon the changes, click on the Cancel button.



Copy

When you select Copy, the track selected on the Track Sheet display is duplicated and 
copied to the destination track, along with any other values that belong to that selected 
track.



Merge

The Merge command combines two tracks together. The track selected on the track menu is 
merge into the destination track. The destination track is specified in the dialog box. The 
channel information is preserved for all events. Assuming that the events of the two tracks 
had different channels, you could use CUT and PASTE to un-merge the track. To extract 
events with a certain channel number, set the channel range in the event filter then cut the 
events from the track.



Select

The Select command is another way of selecting a track, instead of using the mouse or 
cursor keys.



Status

Status determines what mode the track is in when the PLAY button is clicked. The Status 
dialog box allows the setting of Play or Mute mode on the selected track.



Save Mute Map

Saves the track status settings for all tracks into a 'mute map' file. The file may be read at a 
later time to restore the settings using the Load Mute Map command.



Load Mute Map

Loads a previously saved mute map from a 'mute map' file. The file may be selected from 
the File Selector box. 

Related Topic:
Save Mute Map



Erase

The Erase command clears all MIDI events (notes, aftertouch, velocity and controllers) from 
the selected track. The track options are saved (Name, Chan, etc.). Use this command with 
care, as erasing a track is permanent.



Kill

This command completely removes the selected track, its options and events. The 
parameters for that track are reset to the default settings. As with Erase use this with care, 
killing a track is permanent.



Goto Menu
Time
Position
Start
Previous Measure
Next Measure
Bookmark



Time
This command lets you    set a new song position anywhere, Even beyond the end of the 
song at an exact time. The song position is specified in SMPTE/MTC time format.



Position
Goto Position is like Goto Time, but it uses the format of measures:beats:ticks instead of 
SMPTE/MTC time.



Start
Use the this command to set the song position to the start of the song. The difference 
between this and Rewind is that it will ignore the Transport Option's start time. Goto Start 
always goes to position 1:1:0.



Previous Measure
This command sets the song position to the previous measure.



Next Measure
Use this to set the song position to the next measure.



Bookmark
This command provides you with a way maintain bookmarks. The dialog box displays a list of
the bookmarks you have created. The pushbuttons let go to, edit, delete, or add bookmarks. 

To add a bookmark, click on the Add button, then enter the name of the bookmark an its 
position in the next dialog box. The new bookmark will appear in the listbox.

To edit a bookmark. select the bookmark in the listbox, then click on the Edit button. Enter 
the new boundaries in the dialog box.

To delete a bookmark, select the bookmark from the listbox, then click on the Delete button.

To go to a bookmark, select the bookmark from the listbox, then click on the Goto button.



Options Menu
MIDI
Controls
Metronome
Channel Filter
Midi Echo
OverDub
SMPTE Display
Key Signature
Record Tempo
Disable Playback



MIDI
This runs the Big Noise MIDI control panel    program. From this program you can setup the 
MIDI metronome, real-time event filter, and other items. For complete information on this 
program see the MIDI Control Panel documentation.



Metronome
This command controls the use of the metronome feature. How the metronome actually 
works is determined by the MIDI Control Panel    program (see MIDI command). The MIDI 
Control Panel command lets you select either a MIDI metronome or use the PC 's speaker. If 
using the MIDI metronome, the MIDI Control Panel program allows you to select the note 
number and velocity for the beats. A separate note number and velocity can be specified for
the down-beat. The options for the Metronome command are:

Accent:
When enabled. the down-beat is accented. When using the MIDI metronome, the accent is 
determined by settings in the MIDI Control Panel program.

Playback:
Enables the metronome during playback.

Record:
Enables the metronome while recording.

The Metronome dialog box is also used to control the lead-in. Lead-in (also called count in) is
a break just before playback where the sequencer plays the metronome to allow to here the 
rhythm. The lead-in options are:

Beats:
This is the number of beats the metronome will tick before playback begins.

Record:
Enables the lead-in for recording.

Playback:
Enables the lead-in for playback.



Channel Filter
The channel filter is used when recording to limit the recorded events to those on specific 
channels. In order for events from a specific channel to be recorded, the check box next to 
the channel number must be checked.



Controls
The controls command lets you set several of the control parameters from one dialog box. 
Each parameter has its own little box. The parameters are:

Pre-Playback Options
This function allows you to enable certain types of MIDI messages to be transmitted from the
sequencer. The options are:

Chase Controllers:
If enabled, Cadenza sends all control and program changes from the beginning of the song 
to the current position.

Zero Continuous Controllers:
The most commonly used controllers such pitch bend, volume, mod. wheel and pan are set 
to there normal state. ei, pitch bend and pan are centered, volume is set to max and mod. 
wheel is set to zero.

Send Program Changes:
Program changes specified in the Track Sheet's Patch column are sent prior to playback if 
this option is on.

Send Volume:
Volume settings specified in the Track Sheet's Vol. column are sent prior to playback if this 
option is on.

Send Pan:
Pan settings specified in the Track Sheet's Pan column are sent prior to playback if this 
option is on.

Transport Options
This command lets you automate the transport buttons. The features below are enabled 
when the corresponding checkbox is checked. The controls are:

Start Time:
If enabled, Cadenza will set its position to that specified here whenever a rewind is done.

Stop Time:
If enabled. Cadenza will automatically stop during playback when it reaches this song 
position.

Auto Rewind:
When enabled, Cadenza will rewind immediately after it does a stop. 



Punch In/Out
Sets the punch in and punch out positions. Enable must be on for this to work. Punch in/out 
allows you to fix a piece of a track by re-recording the bad spot. To use it, enable punch 
in/out, and set the "In Time" just before the bad spot and the "Out Time" just after it. Start 
recording. When you come to the bad spot, replay the piece. The region inside the in and out
times will be replaced with the stuff you just played.
Everything you have played outside the region will not be recorded. When you stop the 
recording, you can accept or reject the new recording. If you reject the recording, the 
original events will still be there.



MIDI Echo 
Cadenza has the ability to transmit everything that comes into the MIDI In port back out the 
MIDI Out port. This command will turn that feature on or off. This is used mostly when using 
keyboard controllers instead of synthesizers. This setup would require connecting the 
keyboard to the MIDI In port of the interface and the MIDI Out would go to your sound 
generators (synth modules, drum machines, etc).



Overdub
Allows you to record over an existing track without losing the old material. The new material 
is layered onto the old. This command is toggled on and off by selecting it from the menu. 
The check mark indicates that this command is on. With this command off, the old material 
on the current track is erased each time you record over it (but only if you keep the new 
recording).



Key Signature
Selects whether notes are displayed as sharps or flats.



SMPTE Display
The command is used to set the SMPTE display options. The options let you select the frame 
rate which is represented by the SMPTE time in the status bar while using internal sync. The 
Absolute and Relative options determine how the time is displayed while syncing to SMPTE 
or MIDI Time Code. The Absolute option displays the actually SMPTE frame addresses being 
read from the tape. The Relative option subtracts the SMPTE offset from the actual frame 
address. The time displayed becomes the    time from the offset point.



Record Tempo
When checked, enables the recording of tempo changes while Cadenza is recording. This 
means if you make any tempo changes while recording, they will be recorded on the 
conductor track.



Disable Playback
This commands prevents Cadenza from playing back. This used when you wish to play 
another sequencer (which uses the MIDI Director) without hearing the song in Cadenza. 
Otherwise, both sequencers will play at the same time.



Conductor Menu
Tempo
Meter Map
Tap Tempo
Kill Tempo Map



Tempo
Lets you set the tempo. A tempo window (not tempo Map window) will popup. This window 
may remain on the screen as long as you like without keeping you from doing other things. 
When you no longer want the Tempo window on the screen, select its Close button. 

Tempo changes can be recorded on to the conductor track in real time. The Record Tempo 
command in the Options menu is used to enable this feature. Use the Tempo Map window to 
edit the tempo changes that are made inside the song (Past the beginning.). 



Meter Map 
Meter Map lets you specify the meter starting at specified measures. The dialog box lets you
insert new entries, delete entries, and edit existing entries. The selection box displays the 
current entries in the map. It shows the measure and meter change for each entry. Push-
buttons let you edit the map. You can select the buttons with the mouse or by typing the 
underlined letter on the button.



Tap Tempo
Tap Tempo frees you from having to record along with a metronome. After recording a song, 
without the metronome, record a track containing one note for each beat.    Use the Tap 
Tempo command to create a tempo map which matches these beats.    Cadenza will adjust 
event times for all events to match the new tempo map. The playback will be un-effected, 
but the notes will line up with Cadenza's bars and beats. This makes it easier to edit your 
song. You can even quantize.    If you like, you may clear the tempo map. This however, may 
stiffen your music. The Tap Tempo command will prompt you for the track containing the 
beats and the beat value represented by the notes in your 'beat track'. 1 is a whole note, 2 
is half etc. After the command is finished, erase the beat track.



Kill Tempo Map
This command erases all of the tempo changes in the current song. 



Window Menu
This menu contains commands for creating and managing windows.    At the bottom of the 
menu is a list of the currently opened windows. The window names are actually part of the 
menu. You may select these menu entries to display any of the listed windows.

Zoom In
Zoom Out
Follow track
New Window
Tile
Cascade
Save Layout
Restore Layout
Arrange Icons
Close All



Zoom In
This command causes the graphic event windows to display a smaller portion of the song. 
There are three zoom levels. The zoom levels actually determine how many measures will be
displayed. The different levels display 1, 3, or 9 measures.

Related Topic: Zoom Out



Zoom Out
This command causes the graphic event windows to display a larger portion of the song. 
There are three zoom levels. The zoom levels actually determine how many measures will be
displayed. The different levels display 1, 3, or 9 measures.

Related Topic: Zoom In



Follow Track
The Follow Track command is used to lock the event windows to the currently selected track.
The curent track is select from the Track Sheet, Song Editor or Track/Select command.



New Window
This command is used to open a new window.    Selecting this command causes a second 
menu to be displayed which lets you pick the type of window you want to open.

This command will open a Note Editor, Event List, Velocity window, Aftertouch window, Pitch 
Bend window, Controllers window, or Faders window.

For the event windows, the track for which the window is created, is determined by selecting
a track with the Track Sheet or Song Editor before using The New Window command.    The 
Track\Select command may also be used to select the track.

Each of these windows is described in detail in the first half of this manual.



Tile
This command arranges all of the currently displayed windows in a tiled fashion.



Cascade
This command arranges the windows in a cascade fashion. It is similar to a how a hand of 
playing cards would appear.



Save Layout
The save command lets you save the window configuration in a file so that it can be restored
later by using the Restore command.



Restore Layout
The Restore command reads a window configuration file created by the Window\Save 
command. The window arrangement will be restored exactly like the arrangement that was 
saved. The specific data that was being displayed by each window is not guarenteed to be 
correct. Only the window arrangement itself is remembered.



Arrange Icons
This command arranges the Icons at the bottom of the workspace so that they line up nicely.



Close All
This closes all of the displayed windows. The Track Sheet, Song Editor, and Tempo windows 
are not actually closed. Instead, they are minimized.



Track Sheet
The Track Sheet allows you to manage and select tracks. To open the Track Sheet, double-
click on the Track Sheet icon or select Track Sheet under the Window menu. Multiple or 
single tracks can be selected for changing a single parameter at once. Selecting multiple 
tracks also allows you to do edit operations on the selected tracks without having to edit 
each track one at a time.    To select multiple tracks with the keyboard, hold down the shift 
key while using the up or down arrow keys. To select multiple tracks with the mouse, click on
a track and drag the mouse up or down. To select non-adjacent tracks, hold down the shift 
key and click on the desired tracks.
To select parameters with the keyboard, use the right and left arrow keys. To select them 
with the mouse, click inside the column for the parameter. Usually, when selecting a 
parameter with the mouse, you will want to select the track(s) and parameter in one 
operation. If you have selected several tracks and want to edit a different parameter without
re-selecting the tracks, use the right and left arrow keys. 

Layout
Each row in the Track Sheet represents a track. Each column is a parameter for the tracks. To
edit a parameter for a track, you must select the track and parameter. The selected track 
and parameter are highlighted by displaying them as black with white text. Tracks and 
parameters may be selected using the cursor keys (as list below) or clicking on the track and
parameter. 
The Track Sheet will display up to sixty four tracks. The actual number of tracks it will display
depends on the size of its window. Normally the Track Sheet will display a portion of the 
tracks. The window scrolls to allow you to view different portions of the sixty four tracks. 
Scrolling can be done using the positioning keys (arrows, pgup, pgdn etc.) or the scroll bar.

Track Parameters
Name

This may be used for labeling tracks. Its main purpose is to help you identify tracks. To edit 
the name, select the field and press the enter key or double click on the field. A dialog box 
will be displayed to let you enter the name.

Instrument
The instrument field is a powerful feature of the Track Sheet. This field allows to create 
setups for different instruments and give them a name. The setup for each instrument 
includes the port, channel, patch and bank numbers used to select a specific patch on a 
specific synthesizer.
At first there will be no instruments defined. You will need to define your own to match your 
equipment. To create an instrument, double-click in the instrument column in the track of 
your choice. The Instrument    dialog box will be displayed. Type in the name of the 
instrument in the box labeled Instrument Name. In the boxes to the right, enter the values 
for the port, channel, bank and patch. Some of the values are optional. To disable any of the 



values, turn off the check box next to the value. For instance, your instrument may not 
require a bank selection. Click on the check box next to Bank to turn it off if it isn't already. 
When you are done setting all values, click on the OK button. The track settings will be 
adjusted to match the settings for the instrument you just created. 
An alternative to the method above is to set the track parameters in the track sheet before 
bringing up the Instrument dialog box. The values in the dialog box will be the same as the 
track settings. All you still need to do is fill in the Instrument Name field and select the OK 
button. This is actually the preferred method.
After you have created a set of instruments, you will want to use one of them. Double-click 
on the track in the Instrument column to display the Instrument dialog box. The listbox 
contains a list of all the instruments you have created. Select one from the listbox and click 
on the OK button. If your list of instruments is long, you can enter the name in the edit box. 
The list box will display the instrument names which begin with the letters you have typed 
in. In many cases, you can type two or three letters and the instrument you are looking for 
will appear in the list box. When the name does appear, click on it. This will copy the name 
to the edit box. The full name must appear in the edit box in order for it to be considered 
selected.

To delete an instrument, bring up the Instrument dialog box, select the instrument from the 
listbox and click on the Delete button.

Solo
Solo lets a single track play alone. When the solo parameter for a track is on, all other tracks
will be muted. To set solo with the keyboard, select the field, and press the plus key on the 
numeric keypad to turn it on. The minus key turns it off.    You may also toggle the setting 
with the enter key. With the mouse, you can toggle the setting by double-clicking on the 
field.

Status
This parameter mutes and un-mutes tracks. It has two possible values, Mute and Play.    You 
can set the value directly with the keyboard by selecting the field and typing plus or minus 
key on the numeric keypad. Typing the enter key pops up the above dialog box. Use this 
method when you are setting multiple tracks to the same value. You may also pop up this 
dialog by double-clicking on the field with the mouse.

Events  (Not actually a parameter)
This value indicates the number of MIDI events stored in each track. Remember that each 
note has two events (note on and note off).
Chan

This is the channel override parameter. It will force events in the track to play on a fixed 
channel regardless of the channel assigned to them. Channels range from 1 to 16.    The 
channel override may also be turned off.    To set the channel from the keyboard, use the 
arrow keys to select the track and channel field. The plus and minus on the numeric keypad 
can be used to increment and decrement the value. When the channel override is off, it will 
display a dash. Incrementing once will set the channel to one. Decrementing from one will 
turn the override off again. A dash will again be displayed.    To set multiple tracks at once, 
select the tracks and then select the channel column using the arrow keys. Press the enter 
key to display the dialog box below.    In the dialog box, the Channel box can be set from 1 to
16. To turn off the channel override, turn off the Enable checkbox.    To display the dialog box 
with the mouse, double-click on the channel field in the desired track.



Pitch

This is the amount of pitch transposition to apply to notes in the track during playback. Use 
this to transpose all events from a particular track. It does not modify the actual data. The 
range of transposition is -127 to +127 half steps.    To set the transposition from the 
keyboard, use the    arrow keys to select the track and Pitch field. The plus and minus on the 
numeric keypad can be used to increment and decrement the value.    To set multiple tracks 
at once, select the tracks and then select the Pitch column using the arrow keys. Press the 
enter key to display the dialog box below.    Enter the transposition amount into the dialog 
box.    To display the dialog box with the mouse, double-click on the Pitch field in the desired 
track.
Mode

Use this to turn on track looping. In the default position of Linear, the track just plays from 
the beginning to the end. In the Loop setting, the track will loop as long as one other track is
still playing.    To set the mode, select the desired track(s) and press the plus or minus keys 
on the numeric keypad. Press enter to display the dialog box.    You may also double-click on 
the field to display the dialog box.
Bank

This allows you to send an option bank select message to the channel specified in the Chan 
parameter. Numbers range from 0 to 127. If the channel override for this track is disabled, 
the bank select message will not be sent. Editing of this field is done in the same manner as 
the Chan field. 

The bank select message is a control change 1 message. This is a recent standard that is 
currently being adopted by the MIDI industry. However, very few pieces of equipment 
actually use this at this time. As more new equipment starts appearing with the feature, 
Cadenza for Windows will be ready. If you own a piece of equipment that does not do its 
bank selecting in this manner, you may insert the proper messages into the appropriate 
tracks. Unfortunately the methods used to do bank selecting vary from model to model even
with the same brand. For example: the Yamaha FB-01 uses system exclusive messages while
the Yamaha SY77 uses program changes 117 thru 127. Some units won't even let you select 
banks via MIDI. To find out how your equipment does this task, refer to the MIDI Data Format
documentation that hopefully came with the product.

Patch
This allows you to send an optional program change message to the channel specified in the
Chan parameter. Numbers range from 0 to 127. If the channel override for this track is 
disabled, the program    change message will not be sent. Editing of this field is done in the 
same manner as the Chan field. 
Vol

This allows you to send an optional volume message (control change 7) to the channel 
specified in the Chan parameter. Numbers range from 0 to 127.      If the channel override for 
this track is disabled, the volume message will not be sent. Editing of this field is done in the
same manner as the Chan field. 

Pan
This allows you to send an optional pan message (control change 10) to the channel 
specified in the Chan parameter. Numbers range from -64 to +64. Zero is center. If the 
channel override for this track is disabled, the volume message will not be sent. Editing of 



this field is done in the same manner as the Chan field except it does not have a disable 
setting.

Keys
Up Arrow: Selects the previous track.
Down Arrow: Selects the next track.

Right Arrow: Selects the next field to the right.
Left Arrow: Selects the previous field.

PgUp: Scrolls the screen up one page toward track one.
PgDn: Scrolls the screen down one page toward track 64.

Home: Displays the first page of the track sheet.
End: Displays the last page of the track sheet.

Enter: Edits the field. Usually a dialog box will appear for you to fill in.
+ (plus) Increments numeric parameters. Also toggles Mode, and Status. It can also 
turn Solo on.
- (minus) Decrements numeric parameters. Also toggles Mode, and Status. It can also 
turn Solo off.

Mouse
Left Button: Selects tracks and parameters. Dragging the mouse up or down selects 
multiple tracks.

Right Button: Edits parameter pointed to by the cursor. It affects all selected tracks. Hence, 
the right button does not select tracks.

Double Click: Edits the field and track pointed to by the cursor. Only one track can be 
selected this way.

Vertical Scroll Bar
Up Arrow: Scrolls the track sheet up one line.

Down Arrow: Scrolls the track sheet down one line.
Thumb: Scrolls a new track. Track number is determined by position of thumb.

Below thumb: Scrolls the screen up one page toward track one.
Above thumb:Scrolls the screen down one page toward track 64.



Horizontal Scroll Bar
The horizontal scroll bar will only appear when the window has been sized too small for all 
parameters to be viewed. When it appears, you can use it to scroll the track sheet sideways 
to reveal areas that are not currently visible.



Song Editor
The Song Editor lets you view and edit the structure of a song. If makes it easy for you to see
which measures have notes in them and which do not. Sections of a song can be block 
marked by simply dragging the mouse over the region you want to edit. To open the Song 
Editor, double-click on the Song Editor icon or select Song Editor under the Window menu.

Layout

The Song Editor use rectangles to represent measures. White measures are empty. Gray 
measures are filled. Block marking causes marked measures to change color. Marked empty 
measures are filled with a sparse dot pattern. Marked measures with notes are black.
Each row represents a track and each column represents a measure. The tracks are 
numbered along the left edge and the measures are numbered along the top. Every fifth 
measure is numbered.

Keys
Up Arrow: Selects the previous track.
Down Arrow: Selects the next track.

Right Arrow: Steps one measure.
Left Arrow: Backsteps one measure.

PgUp: Scrolls the screen up one page toward track one.
PgDn: Scrolls the screen down one page toward track 64.

Home: Displays the first page of the song editor.
End: Displays the last page of the song editor

Insert: Inserts empty measures into the marked region.
Delete: Deletes the marked measures.

Mouse
Left Button: Used to mark a block. After the button is released, the song position will be set
to the last measure marked. This makes it convenient to go to a measure in a song.
Right Button: Lets you edit the parameters for the track that you click on. The Track Setup 
dialog box will be presented.



Vertical Scroll Bar
Up Arrow: Scrolls the song editor up one line.

Down Arrow: Scrolls the song editor down one line.
Thumb: Scrolls a new track. Track number is determined by position of the thumb.

Below thumb: Scrolls the screen down one page toward track 64.
Above thumb:Scrolls the screen up one page toward track one.

Horizontal Scroll Bar
Right Arrow: Scrolls one measure forward.

Left Arrow: Scrolls one measure back.
Thumb: Locates to a new song position. Song position is determined by position of the 
thumb.
Right of Thumb: Scrolls back one screen full.

Left of thumb:Scrolls forward one screen full.



Tempo Map
The Tempo Map lets you insert tempo changes in your song. They may be gradual or 
immediate. To open the Tempo Map, double-click on the Tempo Map icon or select Tempo 
Map under the Window menu.

A toolbox has been provided for editing. These tools let you select the mouse mode (pick or 
draw) plus several editing functions. To display the toolbox, click anywhere in the Tempo Map
window with the right mouse button. After you select a button the tool box will go away.
Block marking in the Tempo Map is done using the pick tool. Once the pick tool is selected, 
just click the mouse on the start of the block and drag it to the end of the block. Unlike the 
other windows, the Tempo Map only supports one block marked region. If multiple regions 
have been marked, using another window, the Tempo Map will use the block closest to the 
beginning of the song. The commands in the Edit Menu have no effect on the conductor 
track. Even though the Tempo Map allows you to mark a region, it is only affected by the 
toolbox buttons.

To insert tempo changes, use the pencil tool. When the pencil tool is selected, the cursor will
change into a pencil. Click the mouse at the location you want the tempo to change. The 
tempo will change gradually from the previous tempo change.
To edit tempo changes, use the pencil tool. Click on the tempo change and drag the 
rectangle to its new location. When you position the cursor a tempo change, it will turn into 
a crosshair.

To delete tempo changes, use the pick tool. Block the area you want deleted and click on the
erase (eraser) tool button.

One important thing to be aware of, is that the MIDI Director only handles one tempo map at
a time during playback. Each time a copy of Cadenza for Windows (or other sequencer) is 
loaded, the previous copy which owned the tempo map gives it up to the newly loaded 
program. In other words, the last copy of Cadenza for Windows that was loaded determines 
the tempo. However, when you click on the play button in one of the copies of Cadenza for 
Windows, that copy gets the tempo map. So the tempo is determined by the Cadenza for 
Windows that you started the playback from. If you are using external sync, you will want to 
make sure that the correct program is controlling the tempo.



Layout
Graph
The Tempo Map is a line graph.    Tempo changes are displayed as rectangles. Normally the 
rectangles will be white with a black border. If a tempo change occurs in the block marked 
region, it will be solid black.    A moving vertical line (cursor) will indicate the current song 
position. 

Rulers
The ruler on the left indicates the value of the tempo. The range is 1 to 300. The ruler at the 
bottom of the graph numerates the measures. 

Status Bar
At the top of the graph is the cursor position (displayed as Time and Tempo). The cursor 
position displays the time (song position) and pitch bend value to which the mouse cursor is 
pointing. This helps you determine where to place the mouse when you are picking points.

Keys
PgUp: Scrolls up one screen full.

PgDn: Scrolls down one screen full.
Home: Steps to the beginning of the song.

+ (numeric keypad) Zoom in one level.
- (numeric keypad) Zoom out one level.

Mouse
Left Button: Clicking on a tempo change selects it. To mark a block, click away from any 
tempo changes and drag the mouse.
Right Button: Edits and inserts tempo changes.

Horizontal Scroll Bar
Left Arrow: Steps the song back one bar.

Right Arrow: Steps the song forward one bar.
Thumb: Moves to a new song position.

Right of Thumb: Scrolls back one screen full.
Left of Thumb: Scrolls forward one screen full.



Tools
Pick

This selects the pick mode for the cursor. This tool is used mainly for block marking. The pick
tool and the pencil (below) are self exclusive. 

Pencil
This selects the pencil cursor mode. This tool is used mainly for editing and inserting. The 
pencil and the pick tool (above) are self exclusive.
Shift

Shifts the tempo within the marked region. A dialog box will be presented for you to enter 
the amount you want the tempo shifted. You may enter the amount or you may use the 
mouse to indicate the amount of shift you want. To use the mouse, click on a point on the 
screen that represents the reference tempo, then drag the mouse up or down. A rectangle 
will be drawn to show you the original tempo and the new tempo. The amount of shift will be
displayed in the dialog box. After you release the mouse button, the rectangle will go away 
and the graph will be redrawn with the tempo shifted.
Limit

Limits the tempo within the marked region. A dialog box will be presented for you to enter 
the upper and lower limits. You may enter the amount or you may use the mouse to indicate
the limits. To use the mouse, click on a point on the screen that represents a limit, then drag 
the mouse up or down. A rectangle will be drawn to show you the limits. The limits will be 
displayed in the dialog box. After you release the mouse button, the rectangle will go away 
and the graph will be redrawn with the tempo limited.

Erase
Erases all tempo changes within the marked region.

Fit
Adjusts the tempo so that the marked region will take the specified time to play. A dialog box
will be displayed to let you enter the time in minutes and seconds.



Event List
The Event List window displays a list of events in a track. Each row in the list shows the 
event's time, channel, event name and data. The main purpose of this window is to let you 
edit single events. Events may also be inserted or deleted.

Each Event List window displays events from a single track. You must select the track you 
want to view using the Track Sheet or Song Editor before creating the window. To open the 
window, use the New Window command in the Window menu and select Event List. You may 
view several tracks by creating a window for each track.

Events are displayed from top to bottom in the order they are played. The keyboard or scroll 
bar can be used to scroll the list. As you scroll though the list, a cursor points to the current 
event. The song position counter (in the status bar) will be set to the time of the event. This 
is where Cadenza for Windows will begin playing when you start the sequence. 

The current event is identified with a mark at the left of the events. To edit the current event,
press the enter key and enter the new parameters for the event. The dialog box used for this
varies with each type of event. For the most part, they are very similar. Each has an edit box
for the channel, time, and data. Note name and velocities may be edited by playing the MIDI
keyboard. Only the selected field will be affected by the MIDI keyboard. System exclusive 
events have a different type of editor. Editing of system exclusive events is covered in the 
Using Cadenza chapter in the Editing System Exclusive Data section of the manual.
To delete the current event, press the del (delete) key.

To insert an event, scroll to the position where you want to insert the event (optional), and 
press the ins (insert) key. A menu of event types will pop up. Select the event type you want.
A dialog box will be displayed for you to enter the values for the new event.



Layout
The columns in the Event List are:
Time: Shows the exact time the event will play back. The time information is displayed in 
measure:beat:tick format. 
Chan: Indicates the channel on which the event is going to be transmitted . This will be the 
same as the channel it was recorded on unless it has been overridden by the Channel 
Override parameter on the Track Sheet.

Status:Tells whether the event is a note, control change, program change, etc.
Data 1: (not labeled) This is the first data byte of the MIDI message. For notes, it is the
note number, for program change, it is the program number. Knowledge of MIDI messages 
will be helpful to understand the meaning of this item.

Data 2: (not labeled) This is the second data byte of the MIDI message. For notes, it 
specifies velocity. For some events, it means nothing and will not be displayed. Knowledge of
MIDI messages will be helpful to understand the meaning of this item.
Duration: Notes have one extra parameter that displays the duration.

Text Colors

Unless events are block marked, each event type has a unique color. Block marked events 
will always be white text on a black background. The colors for the different event types are:

Notes: Black
Program Change: Green

Control Change: Red
Channel Aftertouch: Blue

Pitch Bend: Magenta
Key Aftertouch: Cyan

Keys
Up Arrow: Steps to the previous event.

Down Arrow: Steps to the next event.
Home: Steps to the first event in the track.

End: Steps to the last event in the track.
PgUp: Steps to the previous bar.

PgDn: Steps to the next bar.
Enter: Edits the current event.



Insert: Inserts an event at the current song position. The first dialog box is used to select the
type of event. The second dialog box is for the event data. The dialog also lets you set the 
song position of the inserted event.

Delete: Deletes the current event.

Mouse
Left Button: Selects an event.
Right Button: Selects and edits an event.

Double-click: Edits an event.

Vertical Scroll Bar
Up Arrow: Steps to the previous event.
Down Arrow: Steps to the next event.

Thumb: Sets the Song Position.
Above Thumb: Steps to previous bar.

Below Thumb:Steps to next bar.

Horizontal Scroll Bar
The horizontal scroll bar will only appear when the window has been sized too small for all 
parameters to be viewed. When it appears, you can use it to scroll the Event List sideways to
reveal areas that are not visible.



Note Editor
The Note Editor is used for editing notes. It displays notes in a style often called "piano roll 
notation". When you look at a piano roll, you see rectangular holes. The position of the holes
determines the pitch of the notes and the timing. The length of the holes determines the 
duration of the notes. In the Note Editor, notes are represented as rectangles. A note's 
duration determines the length of the rectangle. Its pitch determines its vertical position. Its 
song position (event time) determines its horizontal position. The rectangles will normally be
gray, unless they are block marked. Then they are black. This makes it easy to see which 
notes have been block marked. The current note is displayed as a white rectangle with a 
black border. 

Each Note Editor window displays note events from a single track. You should select the 
track you want to view using the Track Sheet or Song Editor before creating the window. To 
open the window, use the New Window command in the Window menu and select Note 
Editor. If you decide to view a different track, you can click on the track (Trk) tool button and 
enter the desired track. You may view several tracks by creating a window for each track. 
Use the New Window command for each window you want to create.

Notes are displayed from left to right in the order they are played. The keyboard or scroll bar
can be used to scroll the window. 

As you step right or left using the arrow keys, the current note will be sounded. This note will
also be displayed as white instead of gray or black. Stepping from note to note also changes 
the song position to that of the current note.
To edit the current note, press the enter key and enter the new parameters for the note into 
the dialog box. 
The note editor can be zoomed in and out to display 1, 3, or 9 measures. The Zoom In and 
Zoom Out commands can be used, or you can use the plus(+) and minus (-) keys on the 
numeric keypad.    To delete the current note, press the del (delete) key.

A toolbox has been provided for editing. These tools let you select the mouse mode (pick or 
draw) plus several editing functions. To display the toolbox, click anywhere in the Note Editor
with the right mouse button. After you select a button the tool box will go away.
The following assumes that the pencil tool is selected:

To insert a note, select the pencil tool. Before you insert a note you should select the note 
value (duration) from the tool box. Point to where the note is to be inserted and click the 
mouse. The mouse must not be pointing to an existing note. 
When pointing the mouse cursor at notes, the cursor will change shape. If you point to the 
end of the note, the cursor will become a horizontal double ended arrow <-->. Anywhere 
else on the note, it will be a crosshair. If the cursor is a hand, you can click and drag    the 
note to any position in the window. If the cursor is the <--> shape, you can click and drag 
the mouse to edit the duration of the note. 

The following assumes that the pick tool is selected:
Block marking in the Note Editor is done by clicking and dragging with the mouse. Click 
anywhere except on a note and drag the mouse to mark the block. To add a block, hold 



down a shift key while dragging the mouse.

You may select notes with the mouse by clicking on them with the left mouse button. About 
the only uses for doing this is to change the song position, selecting a note for deleting or 
hear the note.
The remaining tools will be described below.

Layout
Keyboard
Along the left side of the display is a piano keyboard that will help you find the pitch of a 
particular note in the window. 
Octave

Just below the keyboard, is the number of the octave displayed at the bottom of the window.
This number will change as you scroll the window up or down or change the size of the 
window.
Grid

The dots create a grid that helps you locate the notes. Horizontally, they line up notes with 
keys on the keyboard. Vertically, they help determine the song position of the notes. Each 
column of dots line up with a beat or fraction of a beat. Sometimes, each beat may be 
divided into 2 or 4 columns.

Solid horizontal lines mark the octaves. Each octave begins with a C note. Solid vertical lines
mark the beginning of a new measure. 

Measure Ruler
The ruler at the bottom of the window identifies each measure. The measure number is 
displayed in the center of the measure in the ruler. The ruler also has marks at each beat.
Status Bar

At the top of the Note Editor, is a bar that displays note information. The status bar shows 
pitch, velocity, channel, and song position. As the mouse cursor is moved around the Note 
Editor, the cursor's position is displayed. The status bar will be very useful when editing 
existing notes and inserting new notes.

Keys
Right Arrow: Steps to the next note.
Left Arrow: Steps to the previous note.

Up Arrow: Scrolls the screen down one octave.
Down Arrow: Scrolls the screen up one octave.

PgUp: Scrolls the screen down one screen full of octaves.
PgDn: Scrolls the screen up one screen full of octaves.

Control + PgDn Scroll the screen one forward one screen full.



Control + PgUp: Scrolls the screen backward one screen full.

Delete: Deletes the current note.
Home: Steps to the beginning of the song.

End: Steps to the end of the track.
Enter: Edits the current note.

+ (numeric keypad) Zoom in one level.
- (numeric keypad) Zoom out one level.

Mouse
Left Button / pencil tool: Used to drag a note. The cursor must be located over a 
note. If the cursor shape is a crosshair, the mouse will drag the note's position (song position
and pitch). When the cursor is located at the right end of the note's rectangle, the cursor will
be a <--> shape indicating that the mouse will drag the note's duration.
Left Button / pick tool: Selects notes and blocks. If you click on a note, that note 
will become the current event, If you click the mouse off a note, the mouse will mark a block.
The point where the mouse was clicked marks a block boundary, Drag the mouse and 
release the button at the other block boundary.
Double-click: Double-clicking on a note pops up the Note dialog box. You may edit the note 
by entering new values in the box.

Vertical Scroll Bar
Up Arrow: Scrolls down one octave.
Down Arrow: Scrolls up one octave.

Thumb: Scrolls to an new octave,
Above Thumb: Scrolls down one screen full.

Below Thumb:Scrolls up one screen full.

Horizontal Scroll Bar
Left Arrow: Steps the song back one bar.
Right Arrow: Steps the song forward one bar.

Thumb: Moves to a new song position.
Right of Thumb: Scrolls back one screen full.

Left of Thumb: Scrolls forward one screen full.



Tools
Pick
This selects the pick mode for the cursor. This tool is used mainly for block marking. The pick
tool and the pencil (below) are self exclusive. 
Pencil

The selects the pencil cursor mode. This tool is used mainly for editing and inserting. The 
pencil and the pick tool (above) are self exclusive.

Quantize enable/disable:

When selected, notes edited with the mouse will "snap" to the nearest 32nd note position. 
When it is off, notes will be placed exactly where you put them. How accurately you can 
place notes will depend on the size of the Note Editor window and the resolution of your 
video display. Zooming in and out will also affect accuracy. The most accuracy is achieved by
zooming in to one measure.

Note Symbols:

These tools let you select what length of note gets inserted when inserting notes. These 
range from a whole note to a 64th note.
Dot:

The Dot modifies the length of the notes being inserted. This option is used to create dotted 
notes. In other words, it increases the note length by fifty percent.

Triplet:

This is used for inserting triplets. To insert three eighth notes in the time of two. Select the 
eighth note tool button and the triplet tool button. Now each note you insert will be one 
triplet eighth note.

Velocity:

This tool button lets you specify the velocity of the notes being inserted.

Track:

This tool button lets you select the track to be displayed by this window.

Channel:

This tool button lets you specify the channel assigned to notes being inserted.

Step:
This tool turns on the Step Record mode. When this is on, any notes played on the MIDI 
keyboard will be inserted into the track being displayed by this Note Editor. The value 
(spacing) of the note is determined by selecting one of the note tools (above).    The duration
of the note is determine by the note value button you have selected. The duration can be 
modified by selecting the triplet tool, the dot tool, the legato tool or the staccato tool.    

Step Record only works when the Note Editor is the active window. If two or more Note 



Editors are being displayed simultaneously, only the active Note Editor will step record.

Legato:
The legato tool causes notes that are step recorded to have their full length minus one tick. 
For example, a quarter note will be 479 ticks long.
Staccato:

The Staccato tool causes notes that are step recorded to be recorded with half the full 
length. The song position will still step the full note value (duration).

Lock:
This tool keeps the toolbox from going away after clicking on one of the tool buttons. This 
makes it easier to select your note values while inserting notes or step recording.



Velocity Window
The Velocity View is used to display the velocity values for each note, and allows the use of 
the mouse to edit those values. You can view 1, 3, or 9 measures. Each Velocity window 
displays note events from a single track. You should select the track you want to view using 
the Track Sheet or Song Editor before creating the window. To open the window, use the New
Window command in the Window menu and select Velocity. If you decide to view a different 
track, you can click on the track (Trk) tool button and enter the desired track. You may view 
several tracks by creating a window for each track.

Notes are displayed from left to right in the order they are played. The keyboard or scroll bar
can be used to scroll the window. 

As you step right or left using the arrow keys, the current note will be sounded. A cursor will 
indicate the current note. The cursor is a vertical line that goes from the bottom of the graph
to the top. Stepping from note to note also changes the song position to that of the current 
note.

Block marking in the Velocity window is done using the pick tool. Once the pick tool is 
selected, just click the mouse on the start of the block and drag it to the end of the block. To 
add a block, hold down a shift key while dragging the mouse. 
To edit the current note, press the enter key and enter the new parameters for the note. 

To delete the current note, press the del (delete) key.

Layout
Graph

The Velocity window is a 2D bar graph. The measures are actually thin lines. Each line 
represents a note. The value of the velocity is determined by the height of each line. The 
dotted vertical lines in the graph show the beginning of each measure. A moving vertical line
(cursor) will indicate where the current song position is. 

Rulers
The ruler on the left indicates the value of the velocity. The range is 1 - 127. The ruler at the 
bottom of the graph numbers the measures. 
Status Bar

At the top of the graph is the cursor position (displayed as Cursor and Value). The cursor 
position displays the time (song position) and velocity value that the mouse cursor is 
pointing to. This helps you determine where to place the mouse when you are picking points.

Keys
Right Arrow: Steps to the next note.

Left Arrow: Steps to the previous note.
PgUp: Scrolls back one screen full.



PgDn: Scrolls forward one screen full.

Home: Steps to the beginning of the song.
End: Steps to the end of the track.

Enter: Edits the current note.
Delete: Deletes the current note.

+ (numeric keypad) Zoom in one level.
- (numeric keypad) Zoom out one level.

Horizontal Scroll Bar
Left Arrow: Steps the song back one bar.

Right Arrow: Steps the song forward one bar.
Thumb: Moves to a new song position.

Right of Thumb: Scrolls back one screen full.
Left of Thumb: Scrolls forward one screen full.

Tools
Pick

This selects the pick mode for the cursor. This tool is used mainly for block marking. The pick
tool and the pencil (below) are self exclusive. 

Pencil
The selects the pencil cursor mode. This tool is used mainly for editing and inserting. The 
pencil and the pick tool (above) are self exclusive.
Shift:

Shifts the velocity of block marked notes. A dialog box will be presented for you to enter the 
amount you want the velocity shifted. You may enter the amount or you may use the mouse 
to indicate the amount you want the velocity shifted. To use the mouse, click on a point that 
represents the reference velocity, then drag the mouse up or down. A rectangle will be 
drawn to show you the original velocity and the new velocity. The amount of shift will be 
displayed in the dialog box. After you release the mouse button, the rectangle will go away 
and the graph will be redrawn with the velocity shifted.
Limit:

Limits the velocity of block marked notes. A dialog box will be presented to let you enter the 
upper and lower limits. You may type the limits in or you may use the mouse to indicate the 
limits. To use the mouse, click on a point that represents a limit, then drag the mouse up or 
down. A rectangle will be drawn to show you the limits. The limits will be displayed in the 
dialog box as you drag the mouse. After you release the mouse button, the rectangle will go 



away and the graph will be redrawn with the velocity limited.

Invert:
Invert makes low velocities high, and high velocities low. A velocity of 1 is changed to 127. A 
velocity of 127 is changed to 1. Only block marked notes are affected.
Scale:

Scales the velocity of block marked notes. A dialog box will be presented for you to enter a 
percentage. You may enter the amount or you may use the mouse to indicate an amount. To 
use the mouse, click on a point that represents a reference, then drag the mouse up or 
down. A rectangle will be drawn to show you the scale. The percentage will be displayed in 
the dialog box. After you release the mouse button, the rectangle will go away and the graph
will be redrawn with the velocity scaled.

When using the mouse, the first point can be important. If you click on a level of 100 and 
drag the mouse down to 50, everything will be scaled by fifty percent. The rectangle will 
show you the basepoint and the current point. The ratio between the two determines the 
scale. The scale will be displayed in the dialog box as you drag the mouse.

Track:

This tool button lets you select which track is displayed by this window.



Pitch Bend Window
The Pitch Bend View lets you insert or edit pitch bend events by simply drawing the 
envelope with a mouse. You can select any single track and view 1, 3, or 9 measures. Each 
Pitch Bend window displays pitch bend events from a single track. You should select the 
track you want to view using the Track Sheet or Song Editor before creating the window. To 
open the window, use the New Window command in the Window menu and select Pitch 
Bend. If you decide to view a different track, you can click on the track (Trk) tool button and 
enter the desired track. You may view several tracks by creating a window for each track.

As you step right or left using the arrow keys, the cursor will indicate the current event. The 
cursor is a vertical line that goes from the bottom of the graph to the top. Stepping from 
event to event also changes the song position to that of the current event.
Block marking in the Pitch Bend window is done using the pick tool. Once the pick tool is 
selected, just click the mouse on the start of the block and drag it to the end of the block. To 
add a block, hold down a shift key while dragging the mouse. 

To edit pitch bend data with the mouse, select the pencil tool.    You can then draw the pitch 
bend values in with the mouse.    The existing events will be replaced with the ones you draw
in.
To edit the current event, press the enter key and enter the new parameters for the event. 

To delete the current event, press the del (delete) key.

Layout
Graph

The Pitch Bend window is a 2D line graph of Pitch Bend values. The dotted vertical lines in 
the graph show the beginning of each measure. Each measure is numbered below in the 
ruler. A moving vertical line (cursor) will indicate where the current song position is. 
Rulers

The ruler on the left indicates the value of the pitch bend. The range is -8192 to 8191. The 
ruler at the bottom of the graph numbers the measures. 

Status Bar
At the top of the graph is the cursor position (displayed as Time and Value). The cursor 
position displays the time (song position) and pitch bend value to which the mouse cursor is 
pointing. This helps you determine where to place the mouse when you are editing.

Keys
Right Arrow: Steps to the next event.
Left Arrow: Steps to the previous event.

PgUp: Scrolls back one screen full.



PgDn: Scrolls forward one screen full.

Home: Steps to the beginning of the song.
End: Steps to the end of the track.

Enter: Edits the current event.
Delete: Deletes the current event.

+ (numeric keypad) Zoom in one level.
- (numeric keypad) Zoom out one level.

Horizontal Scroll Bar
Left Arrow: Steps the song back one bar.

Right Arrow: Steps the song forward one bar.
Thumb: Moves to a new song position.

Right of Thumb: Scrolls back one screen full.
Left of Thumb: Scrolls forward one screen full.

Mouse
Left Button / pick tool: Click and drag to mark a block. Holding down the shift key
simultaneously adds a block. 
Left Button / pencil tool: Draws (edits) Pitch Bend graph.

Tools
Pick

This selects the pick mode for the cursor. This tool is used mainly for block marking. The pick
tool and the pencil (below) are self exclusive. 

Pencil
Selects the pencil cursor mode. This tool is used mainly for editing and inserting. The pencil 
and the pick tool (above) are self exclusive.
Limit:

Limits the block marked pitch bend events. A dialog box will be presented for you to enter 
the upper and lower limits. You may enter the amount or you may use the mouse to indicate
the limits. To use the mouse, click on a point on the screen that represents a limit, then drag 
the mouse up or down. A rectangle will be drawn to show you the limits. The limits will be 
displayed in the dialog box as you drag the mouse. After you release the mouse button, the 
rectangle will go away and the graph will be redrawn with the pitch bend limited.



Invert:

Invert makes negative pitch bend positive, and positive pitch bend negative.    Only block 
marked pitch bend events are affected.

Scale:
Scales the block marked pitch bend events. A dialog box will be presented for you to enter a 
percentage. You may enter the amount or you may use the mouse to indicate an amount. To 
use the mouse, click on a point that represents a reference, then drag the mouse up or 
down. A rectangle will be drawn to show you the scale. The scale will be displayed in the 
dialog box as you drag the mouse. After you release the mouse button, the rectangle will go 
away and the graph will be redrawn with the pitch bend scaled.
When using the mouse, the first point can be important. If you click on a level of 100 and 
drag the mouse down to 50, everything will be scaled by fifty percent. The rectangle will 
show you the basepoint and the current point. The ratio between the two determines the 
scale. The scale will be displayed in the dialog box.
Channel:

This tool button lets you select the channel number of the events to view and edit.    Only 
those events that match this channel will be displayed. When editing or inserting events, the
new events will have this channel assigned to them.
Track:

This tool button lets you select which track is displayed by this window.
Smooth:

The Smooth tool adds events to make for finer increments in the pitch bend value changes.   
This tool is useful when too many events have been thinned out.

Thin:
The Thin tool is used for removing excess events.    The purpose is to decrease the number of
events that must be processed, so that timing is maintained accurately during playback.    
Even though MIDI is fast, if you record a lot of data over many tracks, controller data can 
start to 'clog up' the data stream upon playback. Since the MIDI transmission rate is fixed, it 
doesn't matter what sequencer or what computer you use, you can still get a 'bottleneck' of 
data going out the MIDI port.    To help lessen this bottleneck, Cadenza for Windows offers 
the thinning tool.    If you use thinning wisely, it shouldn't affect the playback perceptibly, 
except to tighten up timing. This is because most keyboards send far more controller data 
than is needed to produce the effect desired.    The thinning function removes one event for 
every four events. Repeat the function over to remove more events.
Erase:

The Erase tool erases events that are block marked. 



Aftertouch Window
The Aftertouch View lets you insert or edit aftertouch events by simply drawing the envelope
with a mouse. You can select any single track and view 1, 3, or 9 measures. Each Aftertouch 
window displays aftertouch events from a single track. You should select the track you want 
to view using the Track Sheet or Song Editor before creating the window. To open the 
window, use the New Window command in the Window menu and select Aftertouch. If you 
decide to view a different track, you can click on the track (Trk) tool button and enter the 
desired track. You may view several tracks by creating a window for each track.

As you step right or left using the arrow keys, the cursor will indicate the current event. The 
cursor is a vertical line that goes from the bottom of the graph to the top. Stepping from 
event to event also changes the song position to that of the current event.
Block marking in the Aftertouch window is done using the pick tool. Once the pick tool is 
selected, just click the mouse on the start of the block and drag it to the end of the block. To 
add a block, hold down a shift key while dragging the mouse. 

To edit aftertouch data with the mouse, select the pencil tool.    You can then draw the 
aftertouch values in with the mouse.    The existing events will be replaced with the ones you
draw in.
To edit the current event, press the enter key and enter the new parameters for the event. 

To delete the current event, press the del (delete) key.

Layout
Graph

The Aftertouch window is a 2D line graph of aftertouch values. The dotted vertical lines in 
the graph show the beginning of each measure. Each measure is numbered below in the 
ruler. A moving vertical line (cursor) will indicate the current song position. 
Rulers

The ruler on the left indicates the value of the aftertouch. The range is 1 - 127. The ruler at 
the bottom of the graph numbers the measures. 

Status Bar
At the top of the graph is the cursor position (displayed as Cursor and Value). The cursor 
position displays the time (song position) and aftertouch value to which the mouse cursor is 
pointing. This helps you determine where to place the mouse when you are picking points.

Keys
Right Arrow: Steps to the next event.
Left Arrow: Steps to the previous event.

PgUp: Scrolls back one screen full.



PgDn: Scrolls forward one screen full.

Home: Steps to the beginning of the song.
End: Steps to the end of the track.

Enter: Edits the current event.
Delete: Deletes the current event.

+ (numeric keypad) Zoom in one level.
- (numeric keypad) Zoom out one level.

Horizontal Scroll Bar
Left Arrow: Steps the song back one bar.

Right Arrow: Steps the song forward one bar.
Thumb: Moves to a new song position.

Right of Thumb: Scrolls back one screen full.
Left of Thumb: Scrolls forward one screen full.

Mouse
Left Button / pick tool: Click and drag to mark a block. Holding down the shift key
at the same time adds a block. 

Left Button / pencil tool: Draws (edits) Aftertouch graph.

Tools
Pick
This selects the pick mode for the cursor. This tool is mostly used for block marking. The pick
tool and the pencil (below) are self exclusive. 
Pencil

This selects the pencil cursor mode. This tool is used mainly for editing and inserting. The 
pencil and the pick tool (above) are self exclusive.

Limit:
Limits block marked aftertouch events. A dialog box will be presented for you to enter the 
upper and lower limits. You may type in the limits, or you may use the mouse to indicate the 
limits. To use the mouse, click on a point that represents a limit, then drag the mouse up or 
down. A rectangle will be drawn to show you the limits. The limits will be displayed in the 
dialog box as you drag the mouse. After you release the mouse button, the rectangle will go 
away and the graph will be redrawn with the aftertouch limited.
Invert:



Invert makes low aftertouch high, and high aftertouch low. An aftertouch of 0 is changed to 
127. An aftertouch of 127 is changed to 0. Only    block marked events are affected.
Scale:

Scales block marked aftertouch events. A dialog box will be presented for you to enter a 
percentage. You may enter the amount or you may use the mouse to indicate an amount. To 
use the mouse, click on a point that represents a reference, then drag the mouse up or 
down. A rectangle will be drawn to show you the scale. The percentage will be displayed in 
the dialog box as you drag the mouse. After you release the mouse button, the rectangle will
go away and the graph will be redrawn with the aftertouch scaled.

When using the mouse, the first point can be important. If you click on a level of 100 and 
drag the mouse down to 50, everything will be scaled by fifty percent. The rectangle will 
show the basepoint and the current point. The ratio between the two determine the scale. 
The percentage will be displayed in the dialog box.

Shift:
The Shift tool lets you increase or decrease the values of aftertouch. A dialog box will be 
presented for you to enter the amount of shift. You may enter the amount or you may use 
the mouse to indicate an amount. To use the mouse, click on a point that represents a 
reference, then drag the mouse up or down. A rectangle will be drawn to show you the 
amount of shift. The amount will be displayed in the dialog box. After you release the mouse 
button, the rectangle will go away and the graph will be redrawn with the values shifted.
Channel:

This tool button lets you select the channel number of the events to view and edit.    Only 
those events that match this channel will be displayed. When editing or inserting events, the
new events will have this channel assigned to them.
Track:

This tool button lets you select which track is displayed by this window.
Smooth:

The Smooth tool adds events to make for finer increments in the aftertouch value changes.   
This tool is useful when too many events have been thinned out.

Thin:
The Thin tool is used for removing excess events.    The purpose is to decrease the number of
events that must be processed, so that timing is maintained accurately during playback.    
Even though MIDI is fast, if you record a lot of data over many tracks, controller data can 
start to 'clog up' the data stream upon playback. Since the MIDI transmission rate is fixed, it 
doesn't matter what sequencer or what computer you use, you can still get a 'bottleneck' of 
data going out the MIDI port.    To help lessen this bottleneck, Cadenza for Windows offers 
the thinning tool.    If you use thinning wisely, it shouldn't affect the playback perceptibly, 
except to tighten up timing. This is because most keyboards send far more controller data 
than is needed to produce the effect desired.    The thinning function removes one event for 
every four events. Repeat the function over to remove more events.
Erase:

The Erase tool erases events that are block marked. 





Controllers Window

The Controllers View lets you insert or edit control change events by simply drawing the 
envelope with a mouse. You can select any single track and view 1, 3, or 9 measures. Each 
Controllers window displays control change events from a single track. You should select the 
track you want to view using the Track Sheet or Song Editor before creating the window. To 
open the window, use the New Window command in the Window menu and select 
Controllers. If you decide to view a different track, you can click on the track (Trk) tool button
and enter the desired track. You may view several tracks by creating a window for each 
track.

As you step right or left using the arrow keys, the cursor will indicate the current event. The 
cursor is a vertical line that goes from the bottom of the graph to the top. Stepping from 
event to event also changes the song position to that of the current event.
Block marking in the Controllers window is done using the pick tool. Once the pick tool is 
selected, just click the mouse on the start of the block and drag it to the end of the block. To 
add a block, hold down a shift key while dragging the mouse. 

To edit controller data with the mouse, select the pencil tool.    You can then draw the 
aftertouch values in with the mouse.    The existing events will be replaced with the ones you
draw.
To edit the current event, press the enter key and enter the new parameters for the event. 

To delete the current event, press the del (delete) key.

Layout
Graph

The Controllers window is a 2D line graph of control change values. The dotted vertical lines 
in the graph show the beginning of each measure. Each measure is numbered below in the 
ruler. A moving vertical line (cursor) will indicate where the current song position. 
Rulers

The ruler on the left indicates the value of the controller. The range is 1 - 127. The ruler at 
the bottom of the graph numbers the measures. 

Status Bar
At the top of the graph is the cursor position (displayed as Time and Value). The cursor 
position displays the time (song position) and controller value to which the mouse cursor is 
pointing. This helps you determine where to place the mouse when you are picking points. In
the center of the status bar is the name of the selected controller. You may click on the 
name to select a different controller. A dialog box with a list of controllers will be presented.

Keys
Right Arrow: Steps to the next event.
Left Arrow: Steps to the previous event.



PgUp: Scrolls back one screen full.

PgDn: Scrolls forward one screen full.
Home: Steps to the beginning of the song.

End: Steps to the end of the track.
Enter: Edits the current event.

Delete: Deletes the current event.
+ (numeric keypad) Zoom in one level.

- (numeric keypad) Zoom out one level.

Horizontal Scroll Bar
Left Arrow: Steps the song back one bar.
Right Arrow: Steps the song forward one bar.

Thumb: Moves to a new song position.
Right of Thumb: Scrolls back one screen full.

Left of Thumb: Scrolls forward one screen full.

Mouse
pick tool: Click and drag to mark a block. Holding down the shift key at the same time 
adds a block. 

pencil tool: Draws (edits) Controllers graph.

Tools
Pick
This selects the pick mode for the cursor. This tool is used mainly for block marking. The pick
tool and the pencil (below) are self exclusive. 
Pencil

This selects the pencil cursor mode. This tool is used mainly for editing and inserting. The 
pencil and the pick tool (above) are self exclusive.

Limit:
Limits block marked control change events. A dialog box will be presented for you to enter 
the upper and lower limits. You may type in the limits or you may use the mouse to indicate 
the limits. To use the mouse, click on a point that represents a limit, then drag the mouse up
or down. A rectangle will be drawn to show you the limits. The limits will be displayed in the 



dialog box as you drag the mouse. After you release the mouse button, the rectangle will go 
away and the graph will be redrawn with the events limited.
Invert:

Invert makes low values high, and high values low. A value of 0 is changed to 127. A value of
127 is changed to 0. Only block marked events are affected.

Scale:
Scales the value of block marked control change events. A dialog box will be presented for 
you to enter the percentage. You may enter the amount or you may use the mouse to 
indicate an amount. To use the mouse, click on a point that represents a reference, then 
drag the mouse up or down. A rectangle will be drawn to show you the scale. The 
percentage will be displayed in the dialog box. After you release the mouse button, the 
rectangle will go away and the graph will be redrawn with the values scaled.
When using the mouse, the first point can be important. If you clicked on a level of 100 and 
dragged the mouse down to 50, everything would be scaled by fifty percent. The rectangle 
will show you the basepoint and the current point. The ratio between the two determine the 
scale. The scale will be displayed in the dialog box.
Shift:

The Shift tool lets you increase or decrease the values of a controller. A dialog box will be 
presented for you to enter the amount of shift. You may enter the amount or you may use 
the mouse to indicate an amount. To use the mouse, click on a point that represents a 
reference, then drag the mouse up or down. A rectangle will be drawn to show you the 
amount of shift. The amount will be displayed in the dialog box. After you release the mouse 
button, the rectangle will go away and the graph will be redrawn with the values shifted.

Channel:
This tool button lets you select the channel number of the events to view and edit.    Only 
those events that match this channel will be displayed. When editing or inserting events, the
new events will have this channel assigned to them.

Track:
This tool button lets you select which track is displayed by this window.

Smooth:
The Smooth tool adds events to make for finer increments in the controller value changes.    
This tool is useful when too many events have been thinned out.
Thin:

The Thin tool is used for removing excess events.    The purpose is to decrease the number of
events that must be processed, so that timing is maintained accurately during playback.    
Even though MIDI is fast, if you record a lot of data over many tracks, controller data can 
start to 'clog up' the data stream upon playback. Since the MIDI transmission rate is fixed, it 
doesn't matter what sequencer or what computer you use, you can still get a 'bottleneck' of 
data going out the MIDI port.    To help lessen this bottleneck, Cadenza for Windows offers 
the thinning tool.    If you use thinning wisely, it shouldn't affect the playback perceptibly, 
except to tighten up timing. This is because most keyboards send far more controller data 
than is needed to produce the effect desired.    The thinning function removes one event for 
every four events. Repeat the function over to remove more events.



Erase:

The Erase tool erases events that are block marked. 



Faders
The faders allow you to set controller settings for all sixteen channels. To open the window, 
use the New Window command in the Window menu and select Faders. The fader controls 
are a set of scroll bars. The drop down list box in the upper left corner of the window can be 
used to select which one of the 120 controllers you want the faders to manipulate.    You can 
adjust the controller level for a channel by simply moving a scroll bar slider (thumb). There 
are sixteen faders in the Faders window. Each has a channel number above it. The drop 
down listbox on the right is used to select the output port used by this window. The settings 
range from 0 to 127. When you make changes to the scroll bars, control change messages 
are sent to the instrument receiving the corresponding channel. If you are recording, these 
changes are also recorded. 
If you wish to control more than one type of controller, you may open more fader windows. 
Each one can be assigned to a different controller. 



 Windows Keys
Choose from the following list to review the keys used in Windows:

Cursor Movement Keys
Dialog Box Keys
Editing Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



 Cursor Movement Keys
Key(s) Function
DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



 Dialog Box Keys

Key(s) Function
TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches the one 
you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the command.
ESC Closes a dialog box without completing the command. (Same as 
Cancel)
ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



 Editing Keys
Key(s) Function
Backspace Deletes the character to the left of the cursor. Or, deletes selected text.
Delete Deletes the character to the right of the cursor. Or, deletes selected text.



 Menu Keys
Key(s) Function
Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 
matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 
you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



 System Keys
The following keys can be used from any window, regardless of the application you are 
using.
Key(s) Function
Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 
including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications that are
running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.



 Text Selection Keys
Key(s) Function
SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left or right.
SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window. Or, cancels the selection 
if the next window is already selected.
SHIFT+PAGE UP Selects text up one window. Or, cancels the selection if 
the previous window is already selected.
CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or end (DOWN
ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



 Window Keys
Key(s) Function
ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 
including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications that are
running as icons.
Alt+ENTER Switches a non-Windows application between running in a window and 
running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control menu. 
Or, changes the size of a window when you have chosen Size from the Control menu.





 Current Track

The current track is the track that you have selected using either 
the track sheet, song editor, or Select command. This is the track 
that is affected by regional editing commands. It is also the track 
that will be the destination of anything you record.



 Clipboard

A temporary storage area for cut and copied text or other data. 
You can paste the Clipboard contents into a Windows application 
that understands the format for the data in the Clipboard.

Cadenza for Windows does not use Window's clipboard, therefore 
you cannot copy events from Cadenza to another application.



 PPQN

Beats are divided into units called Parts per Quarter Note (PPQN). 
If the PPQN is 240, then one part (or tick) is 1/240 of a quarter 
note.


